


What is Voice Power for Browsing





VOICE POWER for Browsing is asubset of the full Voice Power package, which is a Voice Recognition system that has been designed to allow users to achieve complete hands free operation of their Windows 95 or Windows NT ver. 4.0 computer system. VOICE POWER is not a Dictation System; it is a command and control system that is simple to install and even easier to use. The following gives a more detailed description of some of the characteristics of VOICE POWER.





First, let’s explain how the software is organized.  There are five distinct groups of commands provided, each group designed to perform a specific function.





The first group is called TYPING MODE COMMANDS. (Not active in the Browser Only Version)  These commands will allow you to do all of the functions that the keyboard is capable of doing.  They include all the function commands such as shift, enter, escape, space, backspace, etc., and all the "F" . They also provide the ability to type verbally using the International Alphabet Code. 





The second group is called BROWSER COMMANDS.  This set of commands will allow you to perform all the functions that can be performed with either the Netscape Navigator or the Microsoft Explorer browser programs.  All of the functions on the tool bar, the directory bar and the location (i.e.  destination) can be controlled verbally.  In addition, all of the menu programs in the menu bar are controllable by voice.





The third group is called the MOUSE COMMANDS. (Not active in the Browser Only Version) These commands will allow you to do all of the functions that a mouse is capable of  doing. They include moving the cursor in any direction; left, right, up, down or diagonally, as well as clicking, double clicking and click and drag.  In performing these movements, you can also control the speed the cursor moves by saying "faster or slower". 





The fourth group is the CUSTOM COMMANDS. (Not active in the Browser Only Version) These commands are selected by the user from the total list of commands available on the system. This allows each user to create a customized command set which conforms to the way he or she is using the system. When this group is activated the other groups cannot be opened.





The last group is called the VERBAL LAUNCH PAD COMMANDS. (Not active in the Browser Only Version) This group allows you to launch other programs on your system and is totally user programmable.  To set it up, simply select the program you wish to launch, add it to the Verbal Launch Pad, associate it with a word or name and, from then on, that program will launch whenever you say its associated name.








Before You Begin





In order to install VOICE POWER for Browsing software you must have the following:





·	Your VOICE POWER software (CD or Floppy Disk or File if downloaded)


	


·	An IBM compatible computer with the following minimum configuration.


	Windows 95 or Windows NT ver 4.0.


	486DX2-66 or faster processor (Pentium 100 or better suggested).


	8 Mb RAM.


	CD-ROM drive for CD installation


	10 Mb Free Hard Disk space.


	A Sound Blaster or Sound Blaster compatible sound card. 


	


·	A microphone. (Voice Power Headset preferred)


	


·	Netscape Navigator ver 3.X or Microsoft Internet Explorer ver 3.X(only needed if Internet browsing is desired)





·	Basic understanding of the Windows 95 / NT ver 4.0 operating system, mouse controls and general computer operation.


Choosing a Microphone





It is extremely important that you use a high quality microphone with VOICE POWER. The better the quality of microphone used, the better VOICE POWER will be able to understand what is spoken.





VoiSys has spent a great deal of time qualifying the microphones we provide. We have evaluated many different brands and styles and have found that VOICE POWER works very well with the following microphones.





·	VoiSys Headset: Provides the Best performance because headset microphones are always 1½ inches away from your mouth. This allows the user to carefully control the noise to signal ratio by adjusting the sensitivity to best fit your voice.


	


·	VoiSys Amplified Desktop: Excellent performance for those users who wish to use a desk mounted microphone. Desktop microphones are subject to ambient sound pickup because of the need to adjust the sensitivity to accommodate a greater distance between speaker and microphone.


	


·	Built-In Microphones: If your computer or lap-top has a microphone built-in to it, you may be able to use it with VOICE POWER. It is important to note that this built-in microphone must be a mid to high end unidirectional microphone. If your microphone is not of high enough quality, your results may be poor.





Connecting the VoiSys Microphones





·	VoiSys Headset Microphone: The headset microphone has two connector leads at the end of the cable. One of the leads is red and the other lead is black. The red lead should be plugged into your sound card’s microphone in plug. The VoiSys headset microphone has an earpiece speaker built-in so you can listen to your sound card’s output through the headphone. If you wish to use the earpiece speaker then you need to plug the black lead into your sound card’s speaker out plug. You do not have to connect the black lead to your sound cards speaker out  if you do not wish to use the earpiece speaker.


	


·	Other Microphones: Please refer to the material that came with your microphone to determine proper installation.





Testing the Microphone





In order to determine if the microphone and sound card are working correctly, use the Windows Sound Recorder to make a brief recording and playback of your voice. To begin this test, do the following:





�


·	Start the Windows Sound Recorder by clicking the Start Button.


·	Click the Programs Button.


·	Click the Accessories Button.


·	Click the Multimedia Button.


·	Click the Sound Recorder Button. 


·	Once the Sound Recorder has loaded, press the bottom right button with the red dot in it. This button is the record button. Begin to speak in a normal tone of voice at the volume you will normally be speaking at. After 3 seconds press the stop button. The stop button is just to the left of the Record button and has a black rectangle in it. Next press the play button which is just to the left of the stop button and has a single right arrow in it. If you hear what you recorded clearly through your speakers or through the headphone speaker, then your sound card is working properly. If you do not hear your recording refer to the list below:





·	Check that the microphone is plugged in correctly.


�


·	Check that the microphone gain is set high enough. This is done through your sound card Mixer Utility (see sound card manual). 








Installing the VOICE POWER Software





DO NOT INSTALL VOICE POWER UNTIL YOU HAVE SUCCESSFULY TESTED YOU MICROPHONE. Once you have verified that your sound card and microphone are working properly, install the VOICE POWER software as follows: If you have not verified that your sound card is working properly, do so now before continuing.





Turn of all other programs including any Virus Protection software.


Insert the VOICE POWER CD in your CD-ROM drive.


�


If the Autorun feature has been enabled on your system, the software will automatically begin installation for you; if it has not then do the following:


Click the Start Button.


Click the Run Button.


Type X:\setup (where X:\ is the drive letter for your CD-ROM drive or floppy drive).


To install from floppy disk, insert disk 1 in floppy drive and follow steps 3, 4 and 5 above.


If you downloaded the Demo Version Run the VP4BRWS.EXE file from the folder where you saved it.


	


�


·	Follow the on screen instructions. The default values should work in most cases.





	


	


	


	


	


	


	


	


	


	


	


	





Select the directory that you wish to install VOICE POWER into. 


�


The default directory is C:\Program Files\Voisys International\Voice Power. Click Next to continue.


	


·	After VOICE POWER has successfully installed itself you will be given the option of running VOICE POWER. Choose yes to run VOICE POWER





�
Using VOICE POWER


�





When VOICE POWER is loaded, it will be running in a maximized size. This means that it will appear as follows at the top of the screen. The browser commands are active when first started. To minimize the VOICE POWER window you simply need to click the minimized button on the VOICE POWER Tool Bar





VOICE POWER will respond to any of the commands on the following tables.





The Tool Bar





The VOICE POWER Toolbar has six buttons located on it. Each of these buttons controls a different feature of the VOICE POWER software. The six buttons are :
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Typing Mode Control (Full version only)


The Typing Mode Control Button indicates whether or not the Typing Mode commands are active. This is indicated by a red light for not active and a green light for active. If this command set is not active it can be activated by clicking the Typing Mode Control Button with the mouse cursor or by saying “Open Typing Mode” or “Open Keyboard”. If this command set is active it can be deactivated by clicking the Typing Mode Control Button with the mouse cursor by saying “Close Typing Mode” or “Close Keyboard”.
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Browser Commands Control


The Browser Commands Control Button indicates whether or not the Browser Commands are active. This is indicated by a red light for not active and a green light for active. If this command set is not active it can be activated by clicking the Browser Commands Button with the mouse cursor or by saying “Open Browser Commands”. If this command set is active it can be deactivated by clicking the Browser Commands Button with the mouse cursor by saying “Close Browser Commands”.
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Mouse Commands Control (Full version only)


The Mouse Commands Control Button indicates whether or not the Mouse Commands are active. This is indicated by a red light for not active and a green light for active. If this command set is not active it can be activated by clicking the Mouse Commands Button with the mouse cursor or by saying “Open Mouse Commands”. If this command set is active it can be deactivated by clicking the Mouse Commands Button with the mouse cursor by saying “Close Mouse Commands”.
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Custom Commands Control (Full version only)


The Custom Commands Control Button indicates whether or not the Custom Command set is active. This is indicated by a red light for not active and a green light for active. If this command set is not active it can be activated only by saying “Open My Commands”. This command set cannot be activated or deactivated by clicking the button If this command set is active it can be deactivated by saying “Close My Commands”. The function of this button is to open the Custom Command Set Edit Function. For information on how the Edit Function works, please refer to Adding Commands to the Custom Command List later in the manual.


�
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Verbal Launch Pad Control (Full version only)


The Verbal Launch Pad Control Button indicates whether or not the Verbal Launch Pad Commands are active. This is indicated by a red light for not active and a green light for active. If this command set is not active it can be activated only by saying “Open Launch Pad”. This command set cannot be activated or deactivated by clicking the button If this command set is active it can be deactivated by saying “Close Launch Pad”. The function of this button is to open the Verbal Launch Pad Edit Function. For information on how the Edit Function works, please refer Adding Applications to Voice Launch Pad later in the manual.
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VOICE POWER Options


The Option Button is used to access the general training mode and the general adjustment mode. This button cannot be activated by voice. In order to open the option menu you must click it with the mouse cursor.





VOICE POWER Commands


VOICE Power’s command vocabulary is speaker independent. This means that the system will recognize most any voice speaking the commands listed below. Be sure to speak the exact words of the command. The commands are organized into separate groups according to use and functionality. These commands can be activated via the tool bar or by voice.





General Activation Commands





Command�
Trained Word�
“Options Window” Description�
�
Open Browser Commands�
�
Activates all of the Browser Commands�
�
Close Browser Commands�
�
Deactivates all of the Browser Commands�
�
Open Keyboard�
�
Displays the Virtual Keyboard Template�
�
Close Keyboard�
�
Closes the Virtual Keyboard Template�
�
Open Mouse Commands�
�
Activates all Mouse commands and functions�
�
Close Mouse Commands�
�
Deactivates all Mouse commands and functions�
�
Open Typing Mode�
�
Activates Typing Mode Commands�
�
Close Typing Mode�
�
De-Activates Typing Mode Commands�
�
Go To Sleep�
�
Causes the entire VoiSys system to enter an inactive mode�
�
Wake Up�
�
Causes the entire VoiSys system to enter an active mode�
�
Open My Commands�
�
Activates all of the commands added to the Custom Command List�
�
Close My Commands�
�
Deactivates all of the commands added to the Custom Command List�
�
Open Launch Pad�
�
Activates all of the applications added to the Verbal Launch Pad�
�
Close Launch Pad�
�
Deactivates all of the applications added to the Verbal Launch Pad�
�



Verbal Launch Pad Commands (Full version only)





Command�
Trained Word�
“Options Window” Description�
�
“name”�
�
Activates the program associated with “name”�
�



Mouse Control Commands (Full version only)





Command�
Trained Word�
“Options Window” Description�
�
Open Mouse Commands�
�
Activates all Mouse commands and functions�
�
Close Mouse Commands�
�
Causes all mouse commands to become inactive�
�
Center�
�
Causes Cursor to Jump to Center of Screen�
�
Click Left�
�
Simulates a Single Left Mouse Button Click�
�
Click Right�
�
Simulates a Single Right Mouse Button Click�
�
Corner One�
�
Causes Cursor to move towards Top Left�
�
Mouse Control Commands Continued (Full version only)





Command�
Trained Word�
“Options Window” Description�
�
Corner Two�
�
Causes Cursor to move towards Top Right�
�
Corner Three�
�
Causes Cursor to move towards Bottom Left�
�
Corner Four�
�
Causes Cursor to move towards Bottom Right�
�
Double Click Left�
�
Simulates a Double Left Mouse Button Click�
�
Double Click Right�
�
Simulates a Double Right Mouse Button Click�
�
Down or South�
�
Causes Cursor to move Down�
�
Faster�
�
Causes Cursor movement to Speed Up�
�
Left or West�
�
Causes Cursor to move to the Left�
�
Press Left�
�
Simulates a Press and Hold of the Left Mouse Button�
�
Press Right�
�
Simulates a Press and Hold of the Right Mouse Button�
�
Release Left�
�
Simulates the Release of the held Left Mouse Button�
�
Release Right�
�
Simulates the Release of the held Right Mouse Button�
�
Right or East�
�
Causes Cursor to move to the Right�
�
Slower�
�
Causes Cursor movement to Slow Down�
�
Stop or Halt�
�
Causes Cursor movement to Stop Moving�
�
Up or North�
�
Causes Cursor to move Up�
�



Typing Mode Commands (Full version only)





Command�
Trained Word�
“Options Window” Description�
�
Open Keyboard�
�
Displays the Virtual Keyboard Template�
�
Close Keyboard�
�
Causes the Virtual keyboard Template to close�
�
Open Typing Mode�
�
Causes all Typing Mode Commands to become active�
�
Close Typing Mode�
�
Causes all Typing Mode Commands to become inactive�
�
Alpha�
�
Types the Letter A�
�
Bravo�
�
Types the Letter B�
�
Charlie�
�
Types the Letter C�
�
Delta�
�
Types the Letter D�
�
Echo�
�
Types the Letter E�
�
Fox-Trot�
�
Types the Letter F�
�
Golf�
�
Types the Letter G�
�
Hotel�
�
Types the Letter H�
�
India�
�
Types the Letter I�
�
Juliet�
�
Types the Letter J�
�
Kilo�
�
Types the Letter K�
�
Lima�
�
Types the Letter L�
�
Mike�
�
Types the Letter M�
�
November�
�
Types the Letter N�
�
Oscar�
�
Types the Letter O�
�
Papa�
�
Types the Letter P�
�
Quebec�
�
Types the Letter Q�
�
Romeo�
�
Types the Letter R�
�
Sierra�
�
Types the Letter S�
�
Tango�
�
Types the Letter T�
�
Uniform�
�
Types the Letter U�
�
Victor�
�
Types the Letter V�
�
Whiskey�
�
Types the Letter W�
�
X-Ray�
�
Types the Letter X�
�
Yankee�
�
Types the Letter Y�
�
Zulu�
�
Types the Letter Z�
�
One�
�
Types the Number 1�
�
Typing Mode Commands Continued (Full version only)





Command�
Trained Word�
“Options Window” Description�
�
Two�
�
Types the Number 2�
�
Three�
�
Types the Number 3�
�
Four�
�
Types the Number 4�
�
Five�
�
Types the Number 5�
�
Six�
�
Types the Number 6�
�
Seven�
�
Types the Number 7�
�
Eight�
�
Types the Number 8�
�
Nine�
�
Types the Number 9�
�
Zero�
�
Types the Number 0�
�
Backslash�
�
Types the Backslash Character \ �
�
Slash or Frontslash�
�
Types the Frontslash Character / �
�
Dot or Period�
�
Types the Period Character .�
�
Colon�
�
Types the Colon Character : �
�
At Sign�
�
Types the At Sign Character @ �
�
Plus or Plus Sign�
�
Types the Plus Sign Character + �
�
Comma�
�
Types the Comma Character ,�
�
Equal or Equal Sign�
�
Types the Equal Sign Character = �
�
Question Mark�
�
Types the Question Mark Character ? �
�
F One�
�
Simulates pressing the F1 Key�
�
F Two�
�
Simulates pressing the F2 Key�
�
F Three�
�
Simulates pressing the F3 Key�
�
F Four�
�
Simulates pressing the F4 Key�
�
F Five�
�
Simulates pressing the F5 Key�
�
F Six�
�
Simulates pressing the F6 Key�
�
F Seven�
�
Simulates pressing the F7 Key�
�
F Eight�
�
Simulates pressing the F8 Key�
�
F Nine�
�
Simulates pressing the F9 Key�
�
F Ten�
�
Simulates pressing the F10 Key�
�
F Eleven�
�
Simulates pressing the F11 Key�
�
F Twelve�
�
Simulates pressing the F12 Key�
�
Shift�
�
Simulates Pressing the Caps Lock Key�
�
Enter or Return�
�
Simulates the Enter Key being pressed and will type the letter in the Virtual Keyboard Highlight Box.�
�
Down�
�
Causes the Keyboard highlight box to move down one square�
�
Left�
�
Causes the Keyboard highlight box to move left one square�
�
Right�
�
Causes the Keyboard highlight box to move right one square�
�
Up�
�
Causes the Keyboard highlight box to move up one square�
�
Backspace�
�
Simulates pressing the Backspace Key�
�
Space�
�
Simulates pressing the Space Bar�
�
Alt or Alt Key�
�
Simulates pressing the Alt Key�
�
Escape or Escape key�
�
Simulates pressing the Escape Key�
�
com�
�
Types the letters com�
�
www�
�
Types the letters www�
�



Browser Commands (Netscape & Internet Explorer)





Command�
Trained Word�
“Options Window” Description�
�
Open Browser Commands�
�
Activates all of the Browser Commands�
�
Close Browser Commands�
�
Deactivates all of the Browser Commands�
�
Back or Go Back�
�
Simulates pressing the Back Button�
�
Bookmarks Menu�
�
Displays the Bookmarks Menu�
�
Browser Commands Continued(Netscape & Internet Explorer)





Command�
Trained Word�
“Options Window” Description�
�
Copy�
�
Performs the Copy to Clipboard function�
�
Cut�
�
Performs the Cut editing function�
�
Directory Menu�
�
Displays the Directory Menu�
�
Edit Menu�
�
Displays the Edit Menu�
�
E-Mail or Get E-Mail�
�
Activates the E-Mail program�
�
Enter or Return�
�
Simulates the Enter Key being pressed�
�
Favorites�
�
Opens Internet Explorer Favorites Menu�
�
File Menu�
�
Displays the  File Menu�
�
Find�
�
Displays the Find Dialog Box�
�
Forward or Go Forward�
�
Simulates pressing the Forward Button�
�
Go Menu�
�
Displays the Go  Menu�
�
Help Menu�
�
Displays the Help Menu�
�
Home�
�
Simulates pressing the Home Button�
�
Images or Show Images�
�
Simulates pressing the Images Button�
�
News or News Groups�
�
Activates the News Browser�
�
Next or Next Link�
�
Causes Internet Explorer to move from Link to Link�
�
Open U  R L�
�
Displays the Open URL Dialog Box�
�
Options Menu�
�
Displays the Options Menu�
�
Paste�
�
Performs the Paste editing function�
�
Print�
�
Simulates pressing the Print Button�
�
Refresh�
�
Simulates pressing the Refresh Button�
�
Reload�
�
Simulates pressing the Reload Button�
�
Search or Net Search�
�
Activates the Internet Search Engine�
�
Select All�
�
Performs the Select All editing function�
�
Stop Load or Stop Loading�
�
Simulates pressing the Stop Button�
�
Undo�
�
Performs the Undo editing function�
�
View Menu�
�
Displays the View Menu�
�
Window Menu�
�
Displays the Window Menu�
�
Menu Left�
�
Moves the Menu Highlight Bar Left �
�
Menu Right�
�
Moves the Menu Highlight Bar Right �
�
Menu Down�
�
Moves the Menu Highlight Bar Down �
�
Menu Up�
�
Moves the Menu Highlight Bar Up  �
�
Page Down or Scroll Down�
�
Performs a Page Down Function�
�
Page Left or Scroll Left�
�
Performs a Page Left Function�
�
Page Right or Scroll Right�
�
Performs a Page Right Function�
�
Page Up or Scroll Up�
�
Performs a Page Up Function�
�






�



Training VOICE POWER


note - this is optional and not required.


�





You have the Option of Training VOICE POWER to better recognize your voice or to recognize a different word.  Training VOICE POWER is done as follows:


·	Make sure that VOICE POWER is activated.


·	Maximize the VOICE POWER program.


�


·	Make sure that the microphone is turned on.


·	Make sure that there is not too much noise in the room.


·	Click the Option Button on VOICE POWER control panel.


·	Click the Train VOICE POWER Button.


·	Select the command to be trained by selecting it from the voice command list .


�


·	Click the Begin Training Button.


·	Click the Start Button.


·	Say the word or phrase in your normal tone of voice (you can substitute words if you wish. Example you can say “Coffee” instead of “Click Left” if you so desire).


·	Click the Accept button when it becomes activated.


·	Click the Start Button for the second time.


·	Say the word of phrase again in your normal tone of voice.


·	Click the Accept button when it becomes activated.


·	Click the Start Button for the third time.


�


·	Say the word of phrase again in your normal tone of voice.


·	Click the Accept button when it becomes activated.


·	Now a new box will ask if you want to accept the newly trained word.


·	If you feel that you spoke normally all three times and there was not too much extra noise then Click the Yes Button.


·	Click OK on the next two screens to exit the Training Mode.


·	Each command can be trained to respond to one other word of phrase.


·	To retrain / change the command word again, simply repeat the training sequence.


�
Adjusting VOICE POWER





VOICE POWER provides you with the ability to adjust the three main attributes of the system; Accuracy, Reaction Time and Sensitivity.





�


To adjust any of these attributes click the Options Button on the VOICE POWER Control Panel.





�


Click the Adjust VOICE POWER Button to display the adjustment screen. 





�


To change any of the three settings simply drag the slide bar to the left or right. In order to drag the slide bar you must place the cursor on top of the slide bar you wish to adjust, press and hold the left mouse button, then slide the bar to the desired setting and release the left mouse button.





The Accuracy setting controls how much effort the system puts into double and triple checking the word spoken to determine what it was. The lower the setting the faster the system is but the recognition rate may be lower. The higher the setting the slower the system will be, but the recognition rate will be higher The range is from 0 to 8000. A setting of around 4000 seems to work well in most cases.





The reaction time controls the amount of time the system waits after it hears a command before it executes the command. Setting the reaction time very high will cause the system to allow a great deal of time to pass this may result in missed commands. For example,  if you say Alpha and then say Bravo too quickly, the system may not recognize Alpha because it heard Bravo as the last command. The opposite is also true. If you set the reaction time too low the system may only hear part of a command. For example, if you say “click left” and you speak slowly, the system will hear “click” as one command and will do nothing (since click is not a valid command) then it will hear “left” as a second command and begin to move the cursor to the left. The range for reaction time is from 0 to 2000. We have found that around 200 is a good setting for most people.





The Sensitivity setting has to do with how much noise is in your environment. The louder the environment, the lower the setting needs to be. The range for sensitivity is from 0 to 4000. Most household and office settings should work well at 400 dB/100.





It is important that you adjust these three settings to match your speaking patterns as well as your environmental noise conditions. Please adjust one setting at a time and test the effect. If you adjust more than one setting at a time you won’t know which one made the difference for you.





�
Adding Applications to Verbal Launch Pad (Full version only)





�


You can add applications to the Verbal Launch Pad very easily. (We have found that a few will not launch because of the way in which they utilize system resources and memory.) To add an application to the Verbal Launch Pad you simply press the Verbal Launch Control Button on the tool bar (last button on right next to the Option button). This will display the following screen:


�


�


This screen shows the applications you have added to the Verbal Launch Pad. Initially it will be empty.  Click the Add Application tab to add an application. 





�


Click the Edit Launch List Button. This will bring you to a listing of all of the applications on your hard drive. You will notice that you will also have access to applications located on your network should you be attached to one.





�


Simply select the directory and the application you desire and highlight it. When you press the up arrow located above the application you will choose a word or name to associate with this application. Once a name has been selected click OK in this and the next box. If you check the Launch List again you will see the application you just added.  To Launch this application you simply say “Open Launch Pad”. This will activate all of the applications you have added. Next you say the name or word you have associated with the application. The Verbal Launch Pad will automatically launch the application and close down when completed. If you had a different Command Set opened when you activated the Verbal Launch Pad, those Command Sets will close while the Verbal Launch Pad is active but will reopen as soon as the Verbal Launch Pad closes.





�
Adding Commands to the Custom Command List (Full version only)





�


The Custom command list allows you to select only the commands that you want to use without having to first open its’ default command list, which contains many commands that you do not want. This feature is ideal for someone who wants to have only a hand full of commands used, but finds them dispersed throughout the complete list of commands. In order to compose your custom command list simply press the Custom Control button on the tool bar (second from right after Option). This will display the following screen:


�


�


Click the Edit button to open the edit function of the Custom Command List. The edit screen is used to add or delete commands from the Custom Command List. The Edit button will display the following screen:








Simply select any command from any of the five application tabs and click the add button. This will add the command to the Custom Commands List which can be activated by saying “Open My Commands”. Once you have done this, you can say any of the commands you have added and they will be executed.





Remember, any command that you have added to the Verbal Launch Pad will also be available to you in your custom command list without the need to first say “Open Launch Pad”. These commands are located in the Launch Tab.





If you wish to delete a command that you have previously added to your Custom Command List you follow the same instructions as used for adding commands, however in this case you select the desired command from the right hand side of the Edit screen, the “Custom Command List” and click the delete button. The system will ask you to confirm your deletion by clicking Yes or No. Select the Yes button if you wish to delete the command. Click OK when done and exit the Edit function.
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